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Preface 
 
This paper serves to show the design of a footbridge step by step. An initial file is available 
for each step. The result of a section will be stored in a file which again serves as initial file 
for the next section.  
For the single sections the data can be entered via the keyboard, as shown in the documen-
tation - additionally we have files which can be imported. 
 

Setting up the drawing 
 
Select the template SOFiCAD_classic.dwt. Working with SOFiCAD-V in the layout area is 
being prepared shortly. 
 

 
 
Standard scale  1:50 
Paper size  DIN A0 
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Toolbox 
 
When loading SOFiCAD-V, the toolbox will either be loaded as well - if not you can do so via 
View - > Toolbox. 
 

 
 

 

Standard cross sections 
 
A standard cross section will be required for the example - it can be inserted with the file 
Q1.dwg.  
 

AutoCAD DesignCenter 
 

 
 
or 
 
Insert -> Block 
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Search the file Q1.DWG with "search"  
Disassemble the block into its original components with the command "original".  
Drop the cross section at the right side on the sheet.  

 
 
The two lines form a section point with the name VOUT - with it the distances for the haunch 
can be interpolated in X-direction. 
 

Setting drawing units 
 
Format -> Units 
 
Angle type:  Grads 
Running direction: Clockwise 
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Direction: North 
 

   
 
DWG File: “V_Workshop_01 Zeichnung einrichten.dwg“ 
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System tree 
 

 Alignment → System tree 
 
The system tree is the central element of SOFiCAD-V. Anything belonging to an alignment 
will be managed via the system tree. The system tree allows looking at data, importing or 
exporting elements. Properties of cross sections can be viewed, section views can be gener-
ated or deleted and cross sections can be copied. An explorer on the left side allows navigat-
ing in the elements - the corresponding data are displayed on the right side.  
 

 
 
To get acquainted with the system tree, please select the file “V_Workshop_10 Absteck-
punkte.dwg”, - where all the elements have been worked in. 
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Axes 
 

Alignment 
 
At first, please select a name for the alignment. Any further element correlates to it. The 
structure will be shown in the system tree with this name. Up to 10 alignments can be de-
fined in one plan.  
 

 or Alignment → Define Alignment 
Alignment name: br 
Alignment insertion point (end): (bottom right in plan) 
 

Draw axis 
 
An alignment can be compiled of several axes. Each of them receives a name. Possible axis 
elements are clothoides, lines and arches in any order. Every element must be entered via 
its parameters (length, A, radius…) as fixed element. 
Viewed from the stationary direction left bent arches are entered with negative and right bent 
arches with positive sign for the radius.   
The display of the axis is done as poly line, a clothoides will be approximated with a sufficient 
amount of circular elements.  
 

 or Alignment → Draw axis 
 
Axis name: B0 
Starting point (end+mit+sch+ein+ext): 8,25 
Tangent direction   (end+mit+sch+ein+ext):100 
Stretch kilometers in km: 0 
[Straight/Arch/clothoides/End/Back]: G 
Length in m: 5 
[Straight/Arch/clothoides/End/Back]: b 
Radius in m: -50 
Length in m<5.0000> or [Angel]: 40 
[Straight/Arch/clothoides/End/Back]: e 
 
The axis can also be imported, which is done via the system tree. 
 

  
 

   B0.acs 
 
V_Workshop_02 Achsen.dwg 
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Drawing gradients 
 

    Alignment → Draw gradient 
 
Gradient name: B0_G 
Starting point of gradient (end+mit+sch+ein+ext): show 
Starting station in km<0.0000>: return 
Height notationstarting station in m: 525 
Current station 0+0.0000. Select option <Polygon>[Polygon/coordinates]: return 
Length of part in m: 17.5 
Longitudinal inclination of part in %: 8 
Current station 0+17.5000. select option <Polygon>[Polygon/coordinates/End]: return 
Length of part in m: 17.5 
Longitudinal inclination of part in %: -8 
Rounding off radius in m<1000.0000>: 250 
Current station 0+35.0000. select option <Polygon>[Polygon/coordinates/End]: e 
 
The gradient can also be read in via the system tree: B0_G.grd 
 
The gradient will be required to design the course of the haunch,  
Therefore copy the gradient and place it at the same place. 
Please turn off the layer T_GRAD, that the gradient indexes will not disturb.  
 
DWG File: “V_Workshop_03 Gradiente.dwg” 
 

Draw cross fall inclination band 
 
The footbridge should also receive a cross fall inclination. 
 

   Alignment → Draw cross fall band 
 
Name of cross fall band: B0_Q 
Starting point cross fall band (end+mit+sch+ein+ext): below gradient 
Type of inclination 
<One-sided inclination>[One-sided inclination/roof profile/Asymmetrically]: return 
Starting station in km<0.0000>: return 
Cross fall station 0+0.0000 in %: 2.5 
Length of part in m: 35 
Cross fall inclination station 0+35.0000 in %: 2.5 
Length of part in m or [End]: e 
 
The cross fall inclination band will not further be required. By turning off the layer T_QNB it 
will be hidden. 
 
DWG File: “V_Workshop_04 Querneigungsband.dwg” 
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Inserting stations 
 
Our bridge should start at the station 0.050 km and end at station 0.030 km. The haunch 
should start 5m from the end.  
 
Stations can be inserted with the command: 

 
 
Station of the inserting point in km or [Show/Interval]: 0.01 
Station of the inserting point in km or [Show/Interval]: 0.03 
Station of the inserting point in km or [Show/Interval]: 0.025 
Station of the inserting point in km or [Show/Interval]: return 
 
DWG File: “V_Workshop_05 Stationen.dwg” 

 

Standard cross section 
 

Define Standard cross section 
 
A cross section must be present as closed poly line. 

   Alignment → define standard cross section 
 
The command Define standard cross section allows selecting a poly line.  
The cross section receives a name and will be attached with its insertion point to the axis.  
The insertion point can still be changed when defining the cross section. 
Block-outs can be defined via additional closed poly lines. 
These points receive properties in order to describe the cross sections behavior along the 
axis.  
The corresponding cross section will be labeled in the system tree and it can then be viewed 
and / or changed.  
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Define standard cross section 
Select poly line: click on the inserted cross section 
Insertion point (end): Click on center point of top line 
 
It is absolutely required to assign the design point for the haunch. 

 
Name of the design point (only capital letters): VOUT 
Show design point (end+mit+sch+ein+ext): Click on section point of bottom line  
The cross section must receive a name - otherwise the dialogue box cannot be exited.  
++ HINT: Standard cross section Q1 has been stored 

 
 
 

 allows making the haunch section point visible. 
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The two outer points 001 and 008 should be corresponding to the cross section inclination 
band. 
For it we have the settings INCL and INCR 
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 Allows checking the cross sections behavior. 
 
 
The points below it should also be moved. For it they need a link to the points above it. 
For point 007: 
 

 
 
 
For selected points height notations shall be written out later. 
 

 
 
The entries for the single points will be displayed in a table: 
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Define area 
 

 
 
The cross sections can be assigned to the axis via the definition of areas  
 

 
 
The points for the beginning and the end of the area can be entered (0.05 and 0.03) or dis-
played.  



 
 
SOFiCAD_V_Workshop05 15 of 28 16.9.2005 

 
 
DWG Files: “V_Workshop_06 Bereich.dwg” 
 

Inserting cross sections 
 
Cross sections shall be inserted from the bridges beginning to its end at every 5m.  

 Alignment → Insert standard cross section 
 
Station or [Show/Interval]: I 
Starting station or [Show]: .005 
Final station or [Show]: .03 
Insertion interval in m<10.0000>: 5 
 
The heights for the inserted cross sections can also be shown. The points were cross off 
when defining the cross section. 
Click on inserted cross section, press the right-mouse button. The right-click menu opens: 
 

 
 
The height notations can be activated. 
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DWG File: “V_Workshop_07 Querschnitte einfügen.dwg“ 

 

Insert section view 
 
The right-click menu allows selecting the command select “section view". 

 
 
DWG File: “V_Workshop_08 Schnittansicht einfügen.dwg“ 
 
 

Data delivery to SOFiPLUS 
 
A double click on area boundaries leads to the dialog box. The command 

 writes the data into the SOFiSTiK CDB. You will be asked for a name 
of the CDB. The name should correspond to the name of the SOFiPLUS-DWG.  
I.e..: c_workshop_01.cdb 
 
With SOFiPLUS the drawing c_workshop_01.dwg will be opened. The command 
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Assigns the system type: 
 

 
 
In this case we use a 3D Truss system: 
 

 
 
ASE is required as analysis model. 
 

  
 
The command "importachsen" (entered via the key board) asks for the CDB with the SOFi-
CAD data.  
 
The truss system appears on the screen. 
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For the truss beginning and end the bearing attributes must be entered.  
 

 
 
For the truss beginning we check PXX, PYY, PZZ and MXX. 
 

 
For the end we check PYY and PZZ. 
 

The command  starts the mesh generation. 
 
The mesh coarseness should be entered as 0.5 in this case.  
 

 
OK generates the system. 

The system can be viewed with the Animator.  
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Design haunches 
 
DWG File: “V_Workshop_09 Voutenkonstruktion.dwg” 
 
Starting from the gradient, the haunch can be designed.  
In this case we introduce the haunches course from the file Voute.dwg. 
Turn on the layer for the gradient. 
Via insert get the file Voute.dwg. 
 

 
 
Disassemble into original. 
Assign insertion point on screen. 
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Insert it at the top left boundary if the gradient 
Turn off the gradient layer again. 
The bottom boundary of the haunch is already a poly line. 

The command  can generated a poly line from this axis. 
Axis name: V1 
Select object: Click on poly line 
Route in km: 0 
 
The haunch should be assigned a gradient to give the haunch a height.  

Open gradient:  
Axis or [V1/B0]: V1 
Gradient name: V1_G 
Gradient starting point (end+mit+sch+ein+ext): Show point below the axis V1 
Starting station in km<0.0000>: return 
Starting station height notation in m: 523.184 
Current station 0+0.0000. Select option <Polygon>[Polygon/Coordinates]: return 
Length of part in m: 40 
Longitudinal inclination of part in %: 0 
Current station 0+40.0000. Select option <Polygon>[Polygon/Coordinates/Ende]: e 
The height notation 523.184 for the starting station results from  
525.00-1.80-part of course of arch 
 
The axis must be assigned in the cross section 
 

 
 
For point 004 the lane will be assigned as Variable 2. Further more for this point the starting 
point 003 and the ending point VOUT must be assigned. The same must be made for the 
point 005. 
Additionally the points 004 and 005 the height notation must be assigned in order to generate 
a longitudinal section.  
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The result: 
 

 
 
In the dialog box the variables A2 must be assigned to the Axis V1.  
 

 
 
Assign via Show 
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Insert longitudinal section: 
Click on area B0_area in the system tree. 
 

 
 
CLick on command Longitudinal section. 
++ HINT Export Haunch A2 
Select Vertex <0000>[0000/0001/0004/0005/0008]: 0004 
insert in gradient? [<Ja>/Nein]: return 
 
The result for this state can also be viewed in SOFiPLUS. 
 

 
DWG File: “V_Workshop_10 Voutenkonstruktion.dwg” 
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Lane enlargement 
Lane boundaries can be generated by moving the axis. Starting from the start and the end 
the enlargement can be designed.  
 
V_Workshop_11 Aufweitung.dwg 
This drawing already contains the enlarged lane boundaries. 
The line courses must be changed to poly lines. 
Command : Change -> Object -> Poly line 
Select poly line or [several objects]: for left and right boundary 
The selected object is not a poly line 
Should it be changed into a poly line? <J> j 
Enter option [CLose/Link/Width/Edit/curve/Adjust/curve line/Delete/Line type/Back]  
Select objects: 1 found 
Select objects: 1 found, 2 total 
Select objects: 1 found 3 total 
Select objects: 1 found 4 total 
Select objects: return 
3 Segment(s) of poly line added 
Enter option [Close/Link/Width/Edit/curve/Adjust/curve line/ line type/back]: return 
 
The poly lines are re-converted into axes. 

 
Axis name: B0_L 
Select object: Poly line left 
Route in km: 0 
 
Axis name: B0_R 
Select object: Poly line right 
Route in km: 0 
 
The cross section must be informed of the boundary axes position.  
The points 001 and 008 receive the variable A3 for the right axis and A5 for the left axis.  
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Further more points 002 follow horizontally the point 001 and 007 the point 008.  
In the following the table with any setting: 
 

 
 
The axes must be assigned to the variables A3 and A5 in the dialog box.  
 

 
 
A3 is left - A5 right 
 
 
Also for the enlagrment, the rusult can be displayed in SOFiPLUS. 
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Slab book / Slab plan 
 
The cross sections can be highlighted in the system tree. The results appear in the right win-
dow. 
The command export writes the values into a .dhp file.  
 

 
 
#DECKENHÖHENPLAN# 
$CSEC_STATION $ASS_STCS $ASS_ACHSE $CR_FALL $CR_FALL_RIGHT $KOTE $KOTE $KOTE $KOTE 
$KOTE 
;Station   Q Achse Q-l[%] Q-r[%]   0/000   0/001   0/004   0/005   0/008 
0+5.0000   Q1  B0  2.5000 2.5000 525.288 525.350 523.487 523.487 525.225 
0+10.0000  Q1  B0  2.5000 2.5000 525.487 525.519 524.589 524.589 525.456 
0+15.0000  Q1  B0  2.5000 2.5000 525.587 525.619 524.689 524.689 525.556 
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0+20.0000  Q1  B0  2.5000 2.5000 525.587 525.619 524.689 524.689 525.556 
0+25.0000  Q1  B0  2.5000 2.5000 525.487 525.519 524.589 524.589 525.456 
0+30.0000  Q1  B0  2.5000 2.5000 525.288 525.350 523.487 523.487 525.225 
# 
 
The text editor allows formatting the values. 
The top line labels the following data as slab height plan. 
The second line lists the order of the columns via key words. The key words are listed in a 
user definition file SOFiCAD.BDD. The format as well as the order can be defined. Thee val-
ues then appear in the defined form in the system tree and in the exported files.  
 
;   Schlüsselwörter und Positionen der QUERSCHNITTS-Parameter 711-720 
;                                                       (alle nur modus 0!) 
; 
;   Schlüsselwort für "Station" in Querschnitt der Im-/Exportdatei 
711        0        String        "$CSEC_STATION" 
;   Position von "Station"                                                      ; notwendig 
712        0        Integer       1 
;   Schlüsselwort für "ass.Regelquerschnitt" in Querschnitt der Im-/Exportdatei 
713        0        String        "$ASS_STCS" 
;   Position von "ass.Regelquerschnitt"                                 ; optional 
714        0        Integer       2 
;   Schlüsselwort für "ass.Achse" in Querschnitt der Im-/Exportdatei 
715        0        String        "$ASS_ACHSE" 
;   Position von "ass.Achse"                                            ; notwendig 
716        0        Integer       3 
;   Schlüsselwort für "Querneigung links" in Querschnitt der Im-/Exportdatei 
717       0        String        "$CR_FALL" 
;   Position von "Querneigung links"                                    ; optional 
718        0        Integer       4 
;   Schlüsselwort für "Kote" in Querschnitt der Im-/Exportdatei 
719        0        String        "$KOTE" 
;   Position von "Kote"                                                 ; optional 
720        0        Integer       6 
;   Schlüsselwort für "Querneigung rechts" in Querschnitt der Im-/Exportdatei 
721        0        String        "$CR_FALL_RIGHT" 
;   Position von "Querneigung rechts"                                   ; optional 
722        0        Integer       5 
 
 

DWG File: “V_Workshop_13 Deckenbuch.dwg” 
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Alignment 

Referencee system and alignment points 
 

Alignment → Define Alignment points 
 
Should the points relate to an axis?? [<Yes>/No]: 
Select axis or [B0/V1/B0_R/B0_L]: B0 
System new 
Name of high axis (one letter) <X>: 
Name of right axis (one letter) <Y>: 
Original of local system (end+mit+sch+ein+ext) or [Constant]: k 
Addition constant of right value: 25157.124 
Addition constant of high value: 48345.621 
Situation of local system (end+mit+sch+ein+ext): 
Point on new high axis (end+mit+sch+ein+ext) or [Second point]:   
Show alignment point (end+mit+sch+ein+ext) or [Coordinates]: 
Name of shown point (max. 10 characters): : 01 
Show alignment point (end+mit+sch+ein+ext) or [Coordinates]: 
Name of shown point (max. 10 characters):  <2>: 02 
Show alignment points (end+mit+sch+ein+ext) or [Coordinates]: 
Name of shown point (max. 10 characters <3>: 03 
Show alignment point (end+mit+sch+ein+ext) or [Coordinates]: 
Name of shown point (max. 10 characters):  <4>: 04 
Show alignment point (end+mit+sch+ein+ext) or [Coordinates]: 
Name of shown point (max. 10 characters):  <5>: 05 
Show alignment point (end+mit+sch+ein+ext) or [Coordinates]: 
Name of shown point (max. 10 characters):  <6>: 06 
Show alignment point (end+mit+sch+ein+ext) or [Coordinates]: 

 
A second reference system A_B (a construction site reference system) with the points 101 
through 111 will be generated.  
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Analyze reference system 

  Alignment → Analyze reference system 
 
Show coordinate cross of local system or [X-Y/A-B]: A-B 
Analyze the system A_B 
Modify selection set of points to be analyzed   Add points 01 and 02 
Select object: 1 found 
Select objects: 1 found 13 total 
Select objects: 
Read into pla? [Yes/<No>]: j 
Starting point (end+mit+pkt+sch+ein+ext): 
Text height in mm<3.500>: 
 

 
 
DWG File: “V_Workshop_14 Absteckpunkte.dwg” 
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